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SHOE LAST SHAPE CUSTOMIZATION

ABSTRACT. In this paper the authors present a method of modelling the shoe last shape, namely the dimensional changes in order to produce a variety of footwear 

products for any category of users. For this, techniques were used to model the last in work sequences of Delcam Crispin 3D application. Using specific tools of this 

application, modules Model Tracer and Last Maker, this paper presents techniques to create a new shoe last. One can study new shoe lasts compared to the initial 

ones using the Comparing function. The method for creating new lasts is useful for footwear manufacturers who can always find the shoe last according to their 

product or can create a new last, similar in shape or different shape from the original one.
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PERSONALIZAREA FORMEI SPAÞIALE A CALAPODULUI

REZUMAT. În aceastã lucrare autoarele prezintã o metodã de modelare a calapodului, respectiv modificãri ale dimensiunilor acestuia pentru a se fabrica o 

diversitate de produse de încãlþãminte, pentru orice categorie de purtãtori. Pentru aceasta s-au folosit tehnici pentru modelarea calapodului în secvenþe de lucru 

ale aplicaþiei Delcam Crispin 3D. Utilizând instrumente specifice ale acestei aplicaþiei, respectiv modulele Model Tracer ºi Last Maker, în lucrare se prezintã tehnici 

pentru crearea unui nou calapod. Se pot studia noile calapoade  comparativ cu cele iniþiale utilizând funcþia de Comparare a douã calapoade. Aceastã metodã 

pentru crearea unui nou calapod este utilã producãtorilor de încãlþãminte la realizarea de noi calapoade similare sau diferite de cel iniþial.

CUVINTE CHEIE: calapod, parametri, înãlþime toc, înãlþime vârf, lungime suprafaþã plantarã 

LA PERSONNALISATION DE LA FORME POUR CHAUSSURES  

RÉSUMÉ. Dans cet article, les auteurs présentent une méthode pour la modélisation de la forme pour chaussure et des variations dimensionnelles pour produire 

une variété de produits de la chaussure pour toutes les catégories d'utilisateurs. Pour cela on a utilisé des techniques de modélisation de la forme dans les 

séquences de travail de l'application Delcam Crispin 3D. Grâce à des outils spécifiques de cette application, c'est-à-dire les modules Model Tracer et Last Maker, 

l'article présente les techniques pour créer une nouvelle forme. Les nouvelles formes peuvent être étudiées par rapport à l'original en utilisant la fonction de 

comparaison de deux formes. Cette méthode pour créer une nouvelle forme est utile pour les fabricants de chaussures dans la construction de nouvelles formes de 

chaussures semblables ou différentes de l'original. 

MOTS-CLÉS: forme chaussures, paramètres, hauteur du talon, hauteur du pic, longueur de la surface plantaire
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INTRODUCERE

Forma spaþialã cea mai complexã ºi indispensabilã 
în fabricarea încãlþãmintei este calapodul. Producãtorii 
cei mai experimentaþi ai produselor de încãlþãminte 
afirmã despre calapod cã este „sufletul” încãlþãmintei. 
Fãrã calapod nu ar exista încãlþãminte, nu ar exista 
industria încãlþãmintei, nu ar exista o modã a 
încãlþãmintei [1]. Totodatã, aceºtia afirmã cã proiectarea 
º realizarea calapodului este procesul cel mai complex ºi 
mai minuþios din întreaga activitate de fabricare a 
încãlþãmintei, pista de lansare a fabricãrii acesteia [2, 3]. 

Nu existã linii drepte pe calapod. Calapodul este o 
continuã alunecare de contururi º configuraþii. În acest 
sens, este considerat „o capodoperã a ingineriei º o 
operã de artã”. 

INTRODUCTION

The last is the most complex spatial form and is 
indispensable in the manufacture of footwear. Even the 
most experienced manufacturers of footwear products 
mentioned the last to be the “soul” of the footwear. 
Without the last there would be no footwear, no 
footwear industry, and no footwear fashion [1]. At the 
same time, they claim that the design and execution of 
the last is the most complex and elaborated process of 
the entire shoe manufacturing business, the launch 
pad of its manufacture [2, 3].

There are no straight lines on the last. The last is 
made of a continuous flow of contours and 
configurations. In this respect, it is considered “a 
masterpiece of engineering and a work of art”.
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Totuºi, þinând cont de modã º de trãsãturile 
caracteristice ale fiecãrui stil, aceste contururi trebuie 
sã respecte standarde precise de mãsurãtori º 
dimensionãri (Figura 1). 

Procesul de definire a formei geometrice a unui 
calapod este unul complex. Specialiºtii în proiectarea 
computerizatã a formelor spaþiale afirmã cã 
proiectarea unui calapod cu ajutorul calculatorului 
cuprinde cele mai avansate tehnici de proiectare: de la 
definirea geometriei formei spaþiale a calapodului pânã 
la obþinerea formei numerice finale a acestuia. Acest 
lucru le permite producãtorilor realizarea tiparelor ºi a 
prototipurilor cu maºini cu control numeric (CNC), 
tehnici utilizate curent în industriile de aeronauticã º 
constructoare de automobile, precum ºi într-o serie de 
aplicaþii care necesitã prelucrare în coordonate spaþiale 
a unor forme tridimensionale [2, 4, 5, 7].

Pe aceastã direcþie au fost elaborate o serie de produse 
soft CAD/CAM specializate în proiectarea calapodului, cu 
interfeþele necesare obþinerii tiparelor de încãlþãminte. 

Pentru aceasta, în continuare se prezintã metodele 
cele mai avansate puse la dispoziþie de sistemul CRISPIN 
Dynamics CAD Suite pentru încãlþãminte, privind 
modelarea formei calapodului cu avantajele 
corespunzãtoare. Prin tehnica prezentatã s-a elaborat o 
metodã de personalizare a formei calapodului în funcþie 
de piciorul purtãtorului de încãlþãminte, ce permite 
producãtorilor de încãlþãminte fabricarea de produse 
pentru toate categoriile de purtãtori de încãlþãminte.
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However, while taking into account fashion and 
the characteristics of each style, the contours must 
meet precise standards of measurement and sizing 
(Figure 1).

The process of defining the geometry of the last 
is a complex one. Specialists in computerized design 
of spatial forms state that computer-aided design of a 
last includes the most advanced design techniques: 
from defining the 3D geometry of the last to obtaining 
its numerical form. This enables manufacturers to 
make patterns and prototypes using Numerical-
Command-Machines (NCM), techniques currently 
used in aerospace and car manufacturing industries 
and a number of applications requiring processing of 
spatial coordinates in three-dimensional shapes [2, 4, 
5, 7].

With this purpose in mind, a series of specialized 
CAD/CAM software products have been developed to 
design lasts, with interfaces for shoe pattern 
production. 

The paper presents some advanced methods 
available from CRISPIN Dynamics CAD Suite for 
footwear, regarding last modelling with its specific 
advantages. A method for customizing the last shape 
based on the user's foot shape was developed using 
the technique presented, allowing footwear 
manufacturers to produce footwear for all types of 
users.
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Figure 1. Different shoe last shapes
Figura 1. Diferite forme de calapoade
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METODÃ

Competiþia tot mai acerbã între producãtorii de 
încãlþãminte ºi moda în continuã schimbare face ca 
adaptarea la piaþã sã devinã o adevãratã provocare. 
Costurile trebuie sã fie controlate cu atenþie, în timp ce 
calitatea produselor trebuie menþinutã la acelaºi 
standard sau chiar îmbunãtãþitã. Aceste elemente 
esenþiale ale producþiei de încãlþãminte pot fi rezolvate 
apelând la tehnica de calcul. În acest scop producãtorii 
de încãlþãminte în colaborare cu programatori de înaltã 
calificare au elaborat sisteme CAD/CAM pentru 
fabricarea încãlþãmintei.

Calapodul poate influenþa potrivirea încãlþãmintei 
pe picior, confortul, dar ºi stilul, ºi aspectul. Încãlþãmintea 
trebuie proiectatã astfel încât sã se potriveascã perfect 
pe picior ºi sã fie confortabilã. Confortul ºi potrivirea sunt 
influenþate de forma calapodului, proprietãþile 
materialelor utilizate, forma piciorului, climatul din 
interiorul încãlþãmintei, culoarea ºi forma ansamblului 
superior al încãlþãmintei. Utilizând sisteme CAD/CAM 
producãtorii pot modifica forma calapoadelor existente 
pentru a crea noi modele. 

S i ste m e l e  C A D / C A M  ex i ste nte  p e r m i t  
dimensionarea, gradarea ºi modificãri asupra aspectului 
calapodului, ce conduc la modelarea personalizatã a unui 
calapod, potrivirea piciorului cu calapodul sau 
modificarea stilului calapodului prin schimbarea valorilor 
parametrilor. În plus, aceste programe pot lua în calcul 
întreaga formã a piciorului ºi asigurã specificaþii pentru o 
mai bunã potrivire a încãlþãmintei pe picior. 

Astfel se pot modela calapoade noi ce faciliteazã 
creºterea calitãþii ºi a aspectului încãlþãmintei (Figura 2). 

METHOD 

Increasing and tougher competition among 
footwear producers makes market adaptability a 
must, one which is increasingly difficult to attain. 
Pricing must be carefully controlled, while the quality 
of the products must remain the same or even 
continuously improve. These requirements can be 
reached only by using computer-aided production. To 
this end, both footwear production and software 
companies joined forces to develop CAD/CAM shoe 
design software.

The design of the last influences not only how 
comfortably a shoe fits the foot, but also how stylish it 
looks.  Footwear must be designed so that it perfectly 
fits the foot and also be comfortable. These aspects 
are influenced by the shape of the last, the properties 
of the materials, the shape of the legs, the thermal 
comfort of the shoe and even the shape and the 
colour of the upper. Using CAD/CAM systems, the 
producers can easily modify the shape of the lasts 
they already have, so that they can create new 
models.

Existing CAD/CAM systems allow sizing, scaling 
and modelling the design of the last, allowing for a 
personalized design to be obtained, a perfect fit of 
the shoe or varying the style of the last by 
introducing different parameters for the design. 
Moreover, the software takes into account the 
whole shape of the foot and produces parameters 
that allow a better fit.

This is how new lasts can be created, facilitating an 
increase in the quality and design of the shoe (Figure 2).
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Figure 2. Customizing the shape of the last
Figura 2. Personalizarea formei calapodului
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Aceastã lucrare prezintã o varietate de metode 
pentru modelarea calapodului, utilizând aplicaþia Last 
Maker, o componentã a sistemului Delcam Crispin 3D, 
utilizând tehnici pentru variaþia parametrilor ºi 
vizualizarea rezultatelor.

Calapodul rezultat din acest proces poate fi trimis 
cãtre maºinile CNC spre execuþia acestuia.

Aceastã aplicaþie oferã funcþii pentru crearea ºi 
modificarea calapodului, crearea celor mai realiste 
modele de încãlþãminte, aplatizarea cu transferul liniilor 
de bazã a modelului înscris pe calapod în plan [3, 4]. 
Sistemul oferã posibilitatea digitizãrii calapodului, 
recentrarea liniilor de ghidare anterioare ºi posterioare, 
obþinerea perechii calapodului (stâng/drept), setarea 
corectã a înãlþimii tocului. Se pot crea linii de ghidare care 
se salveazã împreunã cu calapodul, se poate extinde 
calapodul pentru proiectarea unei ghete/cizme [8]. Tipul 
calapodului poate fi, de asemenea, modificat în funcþie 
de modelul ce se va proiecta. Aplicaþia este modularã, 
dupã cum urmeazã:

?LastMaker – un program ce furnizeazã comenzi 
pentru crearea ºi modificarea calapodului cu 
posibilitatea exportãrii acestuia în diverse 
formate 3D. 

?ShoeDesign – un program pentru crearea 
feþelor de încãlþãminte pe calapodul 3D 
obþinut în ModelTracer or LastMaker. 

În continuare se prezintã metodele cele mai avansate 
puse la dispoziþie de sistemul CRISPIN Dynamics CAD Suite 
pentru încãlþãminte, cu privire la modelarea formei 
calapodului, cu avantajele corespunzãtoare.

Despre Last Maker

Acest sistem oferã noi soluþii pentru producãtorii 
de încãlþãminte. Sistemul are posibilitãþi de recentrare 
a liniilor de bazã, schimbarea piciorului - drept-stâng 
(fãrã o nouã digitizare), corectarea  înãlþimii tocului ºi 
gradarea calapoadelor pentru obþinerea calapoadelor 
de numãr inferior ºi superior numãrului iniþial [5].

Aceastã aplicaþie oferã funcþii pentru crearea unui 
nou calapod ºi modificãri ale dimensiunilor de bazã ale 
calapodului utilizând funcþia Last>Adjust (Figura 3). 

CRISPIN DYNAMICS - CAD SUITE

The paper presents various ways for modelling the 
last, using Last Maker, a component of Delcam Crispin 
3D system, using several techniques for parameter 
changes and for visualizing the result. 

The lasts resulting from the process can be later 
produced using standard numerical command 
equipment - CNC.

This application has functions for creating and 

modifying the shoe last, making realistic designs of 

footwear products, flattening and transferring the base 

lines of the 3D model for development in 2D [3, 4]. The 

software facilitates the digitization of shoe last, re-

centering front and back guide lines, changing foot 

(left/right) and setting the correct heel height. One can 

create guidelines to save with the last and extend the 

last for a boot design [3]. The last type can also be 

changed to a type that allows the entire last surface to 

be used for a design. The application is modular, as 

follows:

?LastMaker - a program providing the means to 

design and modify last width outputs to 

various 3D file formats.

?ShoeDesign - a program for designing uppers 

on 3D lasts provided by ModelTracer or 

LastMaker.

There are presented the most advanced methods 

offered by CRISPIN Dynamics CAD Suite system for 

footwear concerning the modelling process for the 

shoe last shape with the specific advantages.

About Last Maker

LastMaker - a program providing the means to 
design and modify lasts with outputs in various 3D file 
formats. This system offers new solutions for shoe 
makers. The system also facilities to re-centre front and 
back guide lines, change foot right-left (no need to re-
digitize), set the correct heel height and grade shoe 
lasts to obtain lasts for inferior and superior sizes.  

This application offers functions for creating a new 
shoe last and setting the correct base dimensions of the 
shoe last using the Last>Adjust function (Figure 3). 

CRISPIN DYNAMICS - CAD SUITE
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Function 
Funcþii 

Command 
Comandã 

Instrument 
Instrument 

The function for modifying the Toe Spring 
Funcþie pentru modificare To e Spring 

 
Menu>Edit>Last>Adjust>Toe Spring

  

The function for modifying the Heel Height 
Funcþie pentru modificare Heel Height 

 
Menu>Edit>Last>Adjust>Heel Height

  

The function for modifying the Stick Length 
Funcþie pentru modificare Stick Length 

 
Menu>Edit>Last>Adjust>Stick Length  

The function for modifying the Girth 
Funcþie pentru modificare Girth 

 
Menu>Edit>Last>Adjust>Girth 

Functions for Modifying the Basic Dimension of the 
Shoe Last 

The basic geometric parameters of the shoe last 
using the Adjust function are presented in Figure 4.

The function for modifying the basic dimension of 
the shoe last is found in Table 1. 

NOTE:
The paper will use English names for the 5 

parameters; their significance is presented in Figure 4 
and Table 1, location INSTRUMENT.

Funcþii pentru modificarea dimensiunilor de bazã a 
calapodului

Dimensiunile parametrice de bazã ale calapodului 
oferite de funcþia Adjust sunt prezentate în Figura 4.

Funcþiile ºi comenzile pentru modificarea dimensiunilor 
de bazã ale calapodului se regãsesc în Tabelul 1.

NOTÃ:
În lucrare se vor folosi denumirile în englezã ale 

celor 5 parametri, semnificaþia lor fiind prezentatã în 
Figura 4 ºi Tabelul 1, locaþia INSTRUMENT.
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Figure 3. Last>Adjust function's menu
Figura 3. Menul funcþiei Last>Adjust 

Figure 4. The basic geometric parameters of the Adjust function 
Figura 4. Parametrii geometrici de bazã ai funcþiei Adjust

Table 1:  The function for modifying the basic dimensions of the shoe last
Tabelul 1:  Funcþii pentru modificarea dimensiunilor de bazã a calapodului
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OBSERVATION
In each function's box (Figure 5) are written the 

new values for each parameter.

Comparing and Analyzing the New Shoe Last

The comparing function allows the possibility of 
comparing two different lasts; the result can be 
measured or displayed as a solid last [3, 6-8]. First the 
last to be compared is opened; it is possible to have a 
large number of lasts opened and none of them be 
useful for comparison. They can easily be checked, if 
one selects cascade view, using the Window > Cascade 
function.

Now, from the main menu select: Verify > 
Compare > Alignment and the list of all the open files' 
names is brought up (Figure 6). Select the desired last 
and the last is opened and positioned similarly to the 
original last. Last positioning is the next step and 
various translations and rotations are required in order 
to properly position the toe and the back part.

OBSERVAÞIE
În caseta fiecãrei funcþii (Figura 5) se înscriu noile 

valori pentru fiecare parametru.

Compararea ºi analiza noului calapod obþinut

Aceastã funcþie oferã posibilitatea analizei prin 
comparare a douã calapoade diferite, rezultatul putând 
fi mãsurat sau afiºat ca un calapod solid [3, 6-8]. Se 
deschide prima datã calapodul ce urmeazã a fi 
comparat; este posibilã deschiderea unui numãr mare 
de calapoade ºi niciunul dintre ele nu sã nu fie util în 
comparare. Acestea pot fi uºor verificate dacã se 
selecteazã vederea cascadã utilizând funcþia Window > 
Cascade.

Din meniul principal se selecteazã Verify > 
Compare > Alignment ºi lista tuturor fiºierelor deschise 
va fi adusã în prim-plan (Figura 6). Se va selecta 
calapodul dorit ºi acesta este deschis ºi orientat în mod 
similar calapodului original. Pasul urmãtor este 
reprezentat de poziþionarea calapodului, fiind necesare 
translaþii ºi rotaþii succesive pentru a fi încadrate în mod 
corespunzãtor vârful ºi partea posterioarã.
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Figure 5. The window of each basic function
Figura 5. Fereastra de lucru a fiecãrei funcþii de bazã
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Lasts 
Calapoade 

Toe Spring  
Înãlþime vârf 

Heel Height 
Înãlþime toc 

Stick Length 
Lungime suprafaþã 

plantarã 

Bottom Length 
Lungime proiecþie 
suprafaþã plantarã 

Girth 
Perimetru 

 
Last 1 

11.20 29.04 271.25 270.25 235.88 

 
Last 2

7 35.82 199.62 195.96 135.18 

E V A L U A R E A  E X P E R I M E N TA L Ã  A  
PERFORMANÞELOR SOFTULUI

Pentru a evalua experimental metoda de lucru, 
sunt luate în considerare douã scenarii diferite:

?Crearea unui nou calapod, similar ca formã cu 
primul: aceeaºi înãlþime de toc, aceeaºi formã 
de vârf.

?Crearea unui nou calapod cu înãlþime de toc 
diferitã de cel original.

Crearea unui nou calapod similar cu cel iniþial

Sã luãm în considerare douã calapoade de aceeaºi 
formã, dar de dimensiuni diferite, respectiv „Last 1” ºi 
„Last 2”. Dimensiunile celor douã calapoade sunt 
centralizate în Tabelul 2.

EXPERIMENTAL EVALUATION OF SOFTWARE 
PERFORMANCE 

To experimentally evaluate the work method, two 
different scenarios are taken into account:

?Creating a new last, similar in shape with the 
first last - same heel height, same shape of the 
tip.

?Creating a new last, with heel height different 
from the original one.

Creating a New Last, Similar with the Original

Let us consider two lasts of the same shape, but 
with different dimensions - namely Last 1 and Last 2. 
The dimensions for the two lasts are presented in 
Table 2.
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Figure 6. The result for comparing two lasts
Figura 6. Rezultatul comparãrii a douã calapoade

Table 2: The results for creating a new last, similar with the original
Tabelul 2: Rezultatele creãrii unui nou calapod, similar cu cel original
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Lasts 
Calapoade 

Toe Spring 
Înãlþime vârf 

Heel Height 
Înãlþime toc 

Stick Length 
Lungime suprafaþã 

plantarã 

Bottom Length 
Lungime proiecþie 
suprafaþã plantarã 

Girth 
Perimetru 

Last 3  

0.14 29  281 281.56 225 

Last  4

9 82 242 238 209 

The comparative results obtained for modifying 
the first last with the dimensions corresponding to the 
second last are presented in Figure 7.

Creating a New Last with Heel Height Different from 
the Original One

Let us consider two lasts of the same shape, but 
with different dimensions - namely “Last 3” and 
“Last 4”.

Rezultatele comparative obþinute pentru 
modificarea dimensiunilor primului calapod cu 
dimensiunile corespunzãtoare celui de-al doilea 
calapod sunt prezentate în Figura 7.

Crearea unui nou calapod cu înãlþime de toc diferitã 
de cel original

Sã luãm în considerare douã calapoade de aceeaºi 
formã, dar cu înãlþimi de toc diferite, respectiv „Last 3” 
ºi „Last 4”.
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Figure 7. The results for comparing the new last, “Last 1”,
after modifying the parameters of this last with parameters of “Last 2”

Figura 7. Rezultate obþinute pentru compararea formei noului calapod, „Last 1”,
dupã modificarea parametrilor acestui calapod cu dimensiuni ale calapodului „Last 2”

Table 3: The results for creating a new last with different heel height from the original
Tabelul 3: Rezultatele creãrii unui nou calapod cu înãlþimea tocului diferitã de cel original
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The comparative results after modifying the 
dimension of one last for obtaining Last 3 with 
dimensions of Last 4 are presented in Figure 8.

In the past years software solutions have been 
developed in order to fit the shape of the last to the 
shape of the foot. Some of these software solutions 
search in a database for a last whose dimensions are as 
close as possible to the dimensions of the foot. There 
are also software solutions which allow modifying the 
shape of an existing last, in order to fit the shape of the 
foot.

The last's significance in the footwear design, 
modeling, and manufacturing processes is given by the 
fact that its shape determines the footwear shape, 
matching the foot and the comfort characteristics. Due 
to computers and computer science development in 
the recent years, new technologies and software 
applications have been developed for shoe last design, 
modelling and manufacture. 

Using the specific tools of CRISPIN Dynamics CAD 
Suite software, ModelTracer and Last Maker modules, 
a method for creating new shoe lasts has been 
developed in this paper. The method can be useful for 
creating lasts for a variety of footwear. 

The method for creating new lasts is useful for 
footwear manufacturers who can always find the shoe 
last according to their product concept.

CONCLUSIONS

Rezultatele comparative obþinute dupã modificarea 
dimensiunilor calapodului Last 3 cu dimensiunile 
calapodului Last 4 sunt prezentate în Figura 8.

În ultimii ani au fost dezvoltate diferite programe 
software pentru potrivirea formei calapoadelor cu 
forma piciorului. Aceste programe permit cãutarea 
într-o bazã de date cu calapoade, a unui calapod ale 
cãrui dimensiuni sunt cât mai apropiate de 
dimensiunile piciorului. Sunt de asemenea programe 
care permit modificarea formei unui calapod 
preexistent pentru a coincide cu forma piciorului.

Importanþa calapodului în proiectarea, 
modelarea ºi confecþionarea încãlþãmintei este datã de 
faptul cã forma acestuia determinã forma 
încãlþãmintei, rezultând astfel potrivirea cu piciorul ºi 
asigurând confortul dimensional al acestuia. Datoritã 
dezvoltãrii din ultimii ani a posibilitãþilor din domeniul 
calculatoarelor ºi al informaticii s-au realizat noi 
tehnologii ºi aplicaþii software dedicate proiectãrii, 
modelãrii ºi confecþionãrii calapoadelor pentru 
încãlþãminte. 

Utilizând instrumente specifice aplicaþiei CRIPIN 
Dynamics CAD SUITE, modulul Model Tracer ºi Last 
Maker, în aceastã lucrare este prezentatã o metodã 
pentru elaborarea de noi calapoade. 

Metoda pentru crearea de noi calapoade poate fi 
utilã producãtorilor de încãlþãminte care pot gãsi 
oricând un calapod potrivit conceptului de produs.

CONCLUZII

189
Revista de Pielarie Incaltaminte 14 (2014) 3

Figure 8. Comparative results after modifying the dimension of one last
to obtain Last 3 with dimensions of Last 4

Figura 8. Rezultatele comparative obþinute dupã modificarea dimensiunilor calapodului Last 3
cu dimensiunile calapodului Last 4
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